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Overview
This New Features Guide summarizes enhancements in HAP v6.1 which include:

1. Building Modeling

• Added ability to customize floor-to-ceiling heights on a space-by-space basis.
• Revised how level-to-level and floor-to-ceiling heights are defined to improve clarity.
• Modified building surface categorization to make it simpler and more intuitive.

2. Updated Standards Data:

• Added features for ASHRAE Standard 62.1-2019.
• Added features for ASHRAE Standard 90.1-2019.
• Added new EER2, SEER2, COP2, HSPF2 equipment rating metrics.

3. Other Updates:

• Added new Performance Rating Summary report for energy modeling.
• Update default electricity and gas prices for US states using the latest published EIA data.
• Added feature to automatically convert projects created with v6.0 to v6.1 format.

4. Corrected problems in HAP v6.0

The remainder of this Guide explains these and other enhancements in more detail.
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Building Floor Plans
1. Floor-to-Ceiling Height - Added ability to customize floor-to-ceiling heights on a 

space by space basis.  For a given level you can define some spaces with ceiling 
spaces, and some without.  In addition spaces having a ceiling space can use 
different floor-to-ceiling heights for individual spaces, if necessary. 

2. Level Heights - Revised how level-to-level and floor-to-ceiling heights are input for
the overall building defaults and the level properties. This new approach uses a
more visual approach to improve clarity and intuitiveness.

3. Subdividing Spaces - The program now preserves the existing space name when
subdividing spaces during sketch-over of floor plans. Previously subdivided spaces
were each assigned an "unnamed" label when subdividing.

4. Scale Factors. Added new scale factors for large buildings: 1" = 20' and 1" = 40’.

Revised Space Properties window with new features for 
customizing floor to ceiling heights on a 

space by space basis
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Building Floor Plans
5. Model Validation. Strengthened the validation of the building model to detect a wider range of issues that can cause

calculation problems. Validation occurs in the Building Properties window and/or as part of pre-calculation checks.
These validation improvements include detecting:

 Ceiling spaces with zero or near-zero height
 Raised floor spaces with zero or near-zero height.
 Window or door openings whose height exceeds the wall height.
 Window or door openings that conflict with ceiling spaces or raised floor spaces.
 Window or door openings on below grade or partially below grade walls
 Situations where side-by-side levels overlap so two levels partially or wholly occupy the same 3-dimensional space.
 Situations where side-by-side levels have an air wall adjacent to unmodeled space

6. Validation Error Management. Added a feature to the left of the OK button to display the number of validation errors
present in the building model. When no errors are present this feature displays "None". When errors are present the
feature changes to a hyper link and displays the number of errors present. You can click the hyper link to display the list
of errors at any time. Best practice is to correct errors before saving. But you are allowed to save with errors still
present and come back later to correct the problems.
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Space Models
1. Standard 62.1 - Added ability to default ventilation airflow requirements based on ASHRAE Standard 62.1-2019

requirements.

2. Standard 90.1 - Added ability to default overhead lighting power density based on ASHRAE Standard 90.1-2019
requirements.

3. Attic Floor Surface Category – When sloped roof surfaces are modeled and HAP creates an attic space beneath the
roof, a new attic floor surface category will be displayed. This allows separate floor assemblies to be defined for the
attic floor and for floors between occupied levels.

4. Underground Roof Surface Category – For the unusual application where an occupied level is below grade and has
an upper surface with ground contact, HAP will display a surface category for “underground roof”.

5. Ceiling Surface Category - Revised how building surfaces are categorized so that "ceiling" now only refers to a drop
ceiling. Previously in cases where the level above a space was unmodeled, the structural floor above the level was
categorized as a "ceiling" rather than a "floor above space". It will now be categorized as "floor above space".
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Air Systems
General

1. Standard 90.1 - Added ability to determine minimum equipment efficiency per ASHRAE
Standard 90.1-2019 when that is set as the project energy standard. Applies for rooftop,
split DX AHU, vertical packaged unit, VRF, WSHP, GWSHP GSHP, PTAC, PTHP, and warm
air furnace equipment.

2. Standard 62.1 - Added ability to size outdoor ventilation airflow rates based on ASHRAE
Standard 62.1-2019 Ventilation Rate Procedure.

3. Standard 62.1 - The Air Distribution option "Floor supply / ceiling return (low-velocity)" was
removed. This case can now be modeled using the “user-defined" air distribution
effectiveness option.

Rooftops and Split DX AHUs

1. New Rating Metrics - Added equipment performance input options for the new EER2,
SEER2 rating metrics for air-cooled DX equipment. Added new COP2, and HSPF2 rating
metrics for air source heat pumps. The new metrics apply to small capacity rooftop and
split DX equipment. Added new rating metrics for rooftop 

and split DX AHU equipment
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Calculations and Reports
1. PDF - Added toolbar button and menu option to save reports

directly in Adobe Acrobat PDF format

2. Energy Modeling - Added a new Performance Rating
Summary report. The report compares energy use, peak
demand, and energy cost for proposed versus baseline
alternatives. The format and content of the report similar to the
HAP v5.11 report used for LEED minimum energy performance
and optimize energy performance submissions.

The option for this report is found on the Alternatives tab of the
Energy Report Modeling Reports Selection window.

Excerpt from new Performance Rating Summary Report
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Assemblies
1. Added default prescriptive Wall, Roof, and Floor Assemblies for ASHRAE

Standard 90;1-2019. Options to select these assemblies appear in the drop-down
lists on the wall, roof, and floor assembly input windows when 90.1-2019 is
selected as the project energy standard.

2. Added default prescriptive Window, Skylight, and Door Assemblies for
ASHRAE Standard 90.1-2019. Options to select these assemblies appear in the
drop-down lists on the window and door assembly input windows when 90.1-2019
is selected as the project energy standard.

Added default assemblies compliant with 
ASHRAE 90.1-2019 prescriptive requirements.
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Building Wizard
1. Added ability to default ventilation requirements based on ASHRAE Standard 62.1-2019.

2. Added ability to select prescriptive wall, roof, and window assemblies for ASHRAE Standard 90.1-2019.

3. Added defaulting for lighting power density based on ASHRAE Standard 90.1-2019.

4. Increased limit on level to level height from 30 to 100 ft (9.1 to 30.4 m)

Equipment Wizard

Utility Rate Wizard

1. Added new EER2, SEER2, COP2, and HSPF2 rating metrics for rooftop and split DX AHU equipment.

1. Utility Rate Wizard. Updated default electric and gas price data using latest data published by the US Energy
Information Administration (EIA).
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Other Enhancements
1. Added Enter New License Key option to Help Menu. This option can be used to immediately input a new license key

you receive when renewing your software license or converting a trial edition to a licensed edition. The alternative is
waiting until the license is within 30 days of expiration at which point the software will begin asking if you want to enter
an new license key.

2. Added Automatic Data Conversion. If you open a project created with v6.0, HAP will automatically convert it to v6.1
format so it can be used in the new software.

3. ASHRAE 90.1 Schedules. Installs a HAP-6.1-ASHRAE-90.1-Schedules.hap project which contains the full set of
ASHRAE 90.1 reference schedules. This includes ASHRAE 90.1 schedules such as HVAC, elevator, and SHW that
are not part of space type data. This project file is installed in the C:\Users\Public\Public Documents\Carrier Hourly
Analysis Program folder. You can use the Import HAP Project Data option on the Project Menu to import schedules
from this project into your working projects.

4. Added ASHRAE Standard 62.1-2019 to the list of options for the project ventilation standard.

5. Added ASHRAE Standard 90.1-2019 to the list of options for the project energy standard.

6. Corrected software problems identified in HAP 6.0. Please refer to the What’s New in HAP? topic in section 1.2 of
the help system for complete details. The help system can be launched via the Help Menu or by pressing F1.
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More About Automatic Data Conversion
1. When you open a project created by v6.0 it will be converted to 6.1 format automatically. An informational message

appears to make you aware this is happening.

2. The conversion process inserts the word “(converted)” into the project name. This is done so you don’t inadvertently
overwrite the original project file. When you save the project for the first time you can choose save it as a separate file
that different name, or you can choose to overwrite the original project with the original file name, if appropriate.

Note that once you convert a project to 6.1 format, it cannot be opened thereafter in 6.0. Therefore if you will need to
inspect the original project in 6.0, its best to save the converted data in a separately-named file.

3. What happens during conversion? The project file data format sometimes changes when enhancements are made.
The project file is updated to be compatible with that new format. For this update a number of enhancements were made
to building modeling features. Those changes also require building models in the project to be re-extruded.

4. How long will conversion take? The length of the conversion process varies with the size of the project, particularly the
size and complexity of the building model because of the need to re-extrude the model.

a. A small project (100 or fewer spaces) generally takes 20 seconds or less.

b. A medium sized project (a few hundred spaces) could take as much as 2 or 3 minutes.

c. An extremely large project (2000 or more spaces) could take 5to 10 minutes, or more.
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More About Automatic Data Conversion
5. Will calculation results in 6.1 be different than 6.0 for a converted project? Typically, yes, due to the following:

a. Improvements to the process that extrudes the 2-dimensional floor plan into a 3-dimensional model can cause very small changes in
surface areas, and that ultimately can lead to small changes in building loads and energy use. So results in 6.1 will not be exactly the
same as results for the corresponding project in 6.0.

b. Further, if your 6.0 project contained one of the calculation issues that was corrected in 6.1, that correction could cause larger changes in
results. In the help system, the “What’s New in HAP” topic summarizes the problem fixes, including those related to calculations. The
help system can be displayed via the Help Menu or by pressing F1.

6. Translation of Level Heights - In HAP v6.1 the user interface for defining level-to-level height and floor-to-ceiling height
was revised to improve clarity and eliminate misunderstandings. For buildings created in v6.0, the converted data in v6.1
will show how HAP was applying the vertical heights in v6.0. In most cases this data will be exactly as input in v6.0.
However, in some cases, it will appear the conversion changed the input data. That is not the case. This only happens
when the inputs in HAP v6.0 were inconsistent or contradictory. The converted data in HAP v6.1 shows how v6.0 was
interpreting and applying the data. The example on the following page describes the most common situation where this
occurs.
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More About Automatic Data Conversion
6. Translation of Level Heights (continued)

Example:  In HAP 6.0 the Level Properties specify a level-to-level height of 12 ft and a floor to ceiling heigh of 9 ft (Figure 1 below).  The 
difference between the two heights implies the user intends a ceiling space and/or a raised floor to be modeled.  However, the user has not 
checked the boxes for ceiling space or raised floor.  That declares there is not a ceiling space and there is not a raised floor.  This creates 
inconsistent inputs - the heights suggest a ceiling space or raised floor should exist, but neither was declared.  HAP 6.0 interpreted these inputs 
as meaning there is not a ceiling space and not a raised floor.  Since neither exist, the floor-to-ceiling height cannot be 9 ft.  Therefore HAP v6.0 
overrode the floor-to-ceiling input and set it to 12 ft when calculations were performed.  

The revision to the user interface in HAP v6.1 eliminates the possibility of inconsistent inputs and misunderstandings.  In v6.1 a floor-to-ceiling 
height can only be entered if a ceiling space is explicitly declared.  Because HAP v6.0 was interpreting the conflicting inputs as explained 
above, when the inputs in this example are converted to v6.1 the data will show a level to level height of 12 ft and no ceiling space (Figure 2)

Figure 1.  Level Properties Window in HAP v6.0 Figure 2.  Corresponding Level Properties in HAP v6.1
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QUESTIONS?
Please contact Carrier Software Systems at 

software.systems@carrier.com

Thank you!

mailto:software.systems@carrier.com
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